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Kapitel 1

Mbox Einführung
Informationen zur Mbox
Vielen Dank, dass Sie sich für die Mbox 
entschieden haben, eine gemeinsame 
Entwicklung von Digidesign und Focusrite.

Die Mbox stellt einem USB-fähigen Computer 
analoge und digitale Audio-Ein- und -Ausgänge 
unter Verwendung professioneller 24-Bit 
Analog-Digital- und Digital-Analog-Wandlern 
zur Verfügung. 

Zusammen mit Digidesign Pro Tools LE 
verwandelt die Mbox den Computer in eine 
professionelle, digitale Multitrack-Audio-
Workstation.

Im Lieferumfang der Mbox ist folgendes enthalten:

• Mbox Desktop-Audio-Interface

• Installations-CD mit der Software 
Pro Tools LE, RTAS (Real-Time Audio Suite)-
Plug-Ins und Online-Handbüchern im PDF-
Format Außerdem enthalten ist die 
DigiStudio-Software (siehe DigiStudio-
Handbuch).

• Erste Schritte mit Mbox beschreibt die 
Grundlagen der Installation und 
Konfiguration des Geräts und enthält ein 
einführendes Lernprogramm

• USB-Kabel

• Digidesign-Registrierungskarte
Die Funktionen der Mbox
Das Desktop-Audio-Interface der Mbox bietet 
Folgendes:

• zwei Focusrite-Mikrofonvorverstärker mit 
Phantomspeisung

• Symmetrische Vorverstärkereingänge für 
XLR- und 3,5 mm (TRS)-Stecker, die zwischen 
den Eingangspegeln Mic, Line oder 
Instrument umgeschaltet werden können

• Digitale Stereo-S/PDIF-Ein- und -Ausgänge

• Analoge Stereo-Monitorausgänge für 
symmetrische TRS- oder unsymmetrische 3,5 
mm-Stecker

• 24-Bit-A/D- und D/A-Wandler, die Sample-
Raten von 44,1 kHz und 48 kHz unterstützen

• A/D/A-Wandler mit einem dynamischen 
Bereich von >100 dB

• Latenzfreies Abhören der Aufnahme mit 
anpassbarer Balance zwischen Eingängen und 
Wiedergabe

• Analoges TRS-Insert für jeden Eingang

• 6,3 mm(TRS-) oder 3,5 mm-
Stereokopfhörerausgang mit anpassparer 
Pegelsteuerung

• Stromversorgung direkt über den USB-Bus

• Mono-Schalter zum Mischen der Eingangs-
Abhörmischung
Kapitel 1: Mbox Einführung 1
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Funktionen der Pro Tools LE-
Software
Pro Tools LE ermöglicht:

• Aufnahme und Wiedergabe von bis zu 24 
digitalen Mono-Audio-Tracks (12 Stereo), 
abhängig von der Rechnerleistung

• beliebigen Zugriff auf das gesamte 
Audiomaterial (Non-linear/Random-Access-
Editing) und eine Mischautomation

• Verarbeitung von Audiodaten mit bis zu fünf 
RTAS-Plug-Ins pro Track (abhängig von der 
Rechnerleistung)

• Einsatz von bis zu fünf Inserts und fünf Sends 
pro Track

• Routing auf bis zu 16 Busse

• Sessions mit einer Auflösung von 16 oder 24 
Bit

• Aufnahme und Wiedergabe von bis zu 128 
MIDI-Tracks (MIDI-Interface nicht enthalten)

Die Mbox funktioniert nicht 
ordnungsgemäß, wenn sie an einem USB-
Hub angeschlossen wird. Die Mbox muss 
direkt an einer USB-Schnittstelle 
angeschlossen werden. Wenn Sie weitere 
USB-Geräte an einem Hub anschließen 
wollen, müssen Sie den Hub an einer anderen 
Schnittstelle anschließen.

Pro Tools LE verwendet für das Mischen 
und Verarbeiten der Audio-Tracks die CPU 
des Rechners (Host Processing). Computer 
mit schnelleren Taktraten ermöglichen eine 
höhere Anzahl von Tracks und die 
Verarbeitung von zusätzlichen Plug-Ins. 
Weitere Informationen zur Systemleistung 
finden Sie im Pro Tools Referenzhandbuch. 
Erste Schritte mit Mbox
Informationen zu DigiStudio
Pro Tools LE 5.2 ermöglicht den Zugriff auf 
DigiStudio™, einer Umgebung, in der TDM- 
und LE Pro Tools-Benutzer über das Internet 
gemeinsam an Sessions arbeiten können. Stellen 
Sie sich DigiStudio als ein virtuelles Online-
Studio vor, in dem Sie Online-Sessions erstellen 
und bearbeiten können. 

Online-Sessions sind aufgebaut wie Pro Tools-
Sessions mit dem Unterschied, dass mehrere 
Benutzer gleichzeitig an derselben Session 
arbeiten können. Diese Benutzer müssen sich 
nicht im gleichen Studio und nicht einmal im 
gleichen Land befinden. Jeder Benutzer, der ein 
Pro Tools-System und eine Internet-Verbindung 
hat, kann mit Ihnen in einer Online-Session 
zusammenarbeiten. 

Wenn Sie DigiStudio nutzen wollen, müssen Sie 
zuerst die Mbox und Pro Tools LE entsprechend 
den Anweisungen in Erste Schritte mit der Mbox 
(diesem Handbuch) installieren. Danach finden 
Sie Anweisungen zum Installieren und 
Konfigurieren von Pro Tools für DigiStudio im 
DigiStudio-Handbuch.

Systemanforderungen

Zum Einsatz der Mbox auf einem Macintosh 
benötigen Sie:

• Pro Tools LE 5.2 oder höher

• einen für Digidesign empfohlenen Power 
Macintosh

• Mac OS 9.1 oder höher

• mindestens 128 MB RAM (192 empfohlen)



              
• CD-ROM oder entsprechendes optisches 
Laufwerk

• QuickTime Version 5.0 oder höher (im 
Lieferumfang von Pro Tools LE ist Version 
5.0.2 enthalten)

• OMS Version 2.3.8 oder höher (im 
Lieferumfang von Pro Tools LE enthalten)

Informationen zur Kompatibilität

Digidesign kann die Kompatibilität und 
technische Unterstützung nur für diejenigen 
Hardware- und Software-Komponenten 
zusichern, die nach entsprechender Prüfung 
empfohlen werden konnten. Eine Liste der 
Computer, Betriebssysteme und Geräte von 
Drittanbietern, die für Digidesign geeignet sind, 
finden Sie auf der Digidesign-Website unter den 
aktuellen Kompatibilitätsinformationen:

www.digidesign.com/compato/

Festplatten-Anforderungen
Für das Aufnehmen und Speichern von 
Audiodaten auf dem Macintosh werden für 
Pro Tools LE eine oder mehrere mit Digidesign 
kompatible ATA/IDE- oder SCSI-Festplatten mit 
den folgenden Eigenschaften benötigt:

• Formatierung im Dateisystem HFS oder HFS+

• Datenübertragungsrate von mindestens 
3 MB/s

• Laufwerksgeschwindigkeit von mindestens 
7.200 RPM

• Durchschnittliche Positionierungszeit von 
höchstens 10 ms

Aktuelle Informationen zur Kompatibilität 
von Festplatten und SCSI Host Bus-
Adaptern finden Sie auf der Digidesign-
Website (www.digidesign.com/compato/).
Verwenden von Systemlaufwerken für 
Audiodateien

Pro Tools lässt zwar die Aufnahme auf das 
Systemlaufwerk zu, von dieser Einstellung wird 
jedoch im Allgemeinen abgeraten. 
Systemlaufwerke weisen i.d.R. eine geringere 
Aufnahme- und Wiedergabeleistung auf als 
externe Laufwerke, wodurch die mögliche 
Anzahl der Tracks und der verwendeten Plug-Ins 
reduziert wird.

Daher sollten Sie nur im Notfall auf 
Systemlaufwerke aufnehmen, etwa wenn Sie 
über nur eine Festplatte verfügen oder die 
anderen Laufwerke voll sind.

SCSI-Festplatten

SCSI-Festplatten bieten gegenüber ATA/IDE-
Festplatten einige Vorteile. Erstens können 
SCSI-Festplatten extern angeschlossen werden 
und ermöglichen damit das Speichern der 
Audiodaten auf einem tragbaren Medium und 
die problemlose Bereitstellung der Daten für 
verschiedene Systeme. Zweitens bieten SCSI-
Festplatten einen etwas besseren 
Datendurchsatz bei der Aufnahme einer großen 
Anzahl von Tracks, während die Aufnahme 
einer hohen Anzahl von Audio-Tracks auf eine 
ATA/DE-Festplatte nur mit einer kurzzeitigen 
Verzögerung des Aufnahmebeginns möglich ist.

Initialisieren und Defragmentieren von 
Festplatten

Wir empfehlen, mit einem neu formatierten 
Audiolaufwerk zu beginnen. Außerdem sollten 
Sie das Audiolaufwerk regelmäßig 
defragmentieren, um eine kontinuierliche, 
stabile Systemleistung zu gewährleisten.
Kapitel 1: Mbox Einführung 3
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Festplattenspeicher

Mono-Audio-Tracks, die mit einer Auflösung 
von 16 Bit und einer Sample-Rate von 44,1 kHz 
in CD-Qualität aufgenommen werden, belegen 
pro Minute ungefähr 5 MB Festplattenspeicher. 
Bei einer Auflösung von 24 Bit benötigen die 
gleichen Tracks ungefähr 7,5 MB Speicherplatz 
pro Minute. In der folgenden Tabelle finden Sie 
eine Auflistung des für eine bestimmte 
Trackanzahl mit einer bestimmten Länge 
benötigten Speicherplatzes. Richten Sie sich bei 
der Entscheidung, wie viel Festplattenspeicher 
Sie benötigen, nach den folgenden Angaben.

Für Audio-Tracks benötigter Festplattenspeicher

Anzahl der 
Tracks 
und Länge

16 Bit 
bei 

44,1 
kHz

16 Bit 
bei
48 
kHz

24 Bit 
bei

44,1 
kHz

24 Bit 
bei
48
kHz

1 Mono-
Track, 
1 Minute

5 MB 5,5 MB 7,5 MB 8,2 MB

1 Stereo-
Track (oder 
zwei Mono-
Tracks)
5 Minuten

50 MB 55 MB 75 MB 83 MB

1 Stereo-
Track (oder 
zwei Mono-
Tracks)
60 
Minuten

600 
MB

662 
MB

900 
MB

991 
MB

24 Mono-
Tracks
5 Minuten

600 
MB

662 
MB

900 
MB

991 
MB

24 Mono-
Tracks
60 
Minuten

7 GB 7,8 GB 10,5 
GB

11,6 
GB
Erste Schritte mit Mbox
Informationen zu den 
Handbüchern
Im vorliegenden Handbuch Erste Schritte mit der 
Mbox wird erklärt, wie Sie die Mbox installieren 
und zum Aufnehmen, Bearbeiten und Mischen 
von mehreren Audio-Tracks in Pro Tools LE 
verwenden. Weitere Informationen finden Sie 
in den folgenden Online-Handbüchern:

• Das Pro Tools Referenzhandbuch beschreibt 
Pro Tools LE ausführlich

• Das DigiStudio-Handbuch beschreibt das 
Einrichten, Konfigurieren und den Einsatz des 
virtuellen Online-Studios mit DigiStudio

• Das DigiRack Plug-Ins Handbuch beschreibt die 
Verwendung der RTAS- und der AudioSuite-
Plug-Ins, die im Lieferumfang von 
Pro Tools LE enthalten sind.

• Das Handbuch zu MIDI-Bedienoberflächen 
erklärt den Einsatz von MIDI-
Bedienoberflächen (z.B. das HUI von Mackie) 
zur Steuerung von Pro Tools LE.

• Die Tastenkombinationskarten (Macintosh und 
Windows) bieten einen Überblick über alle 
Tastenkombinationen für Pro Tools LE.

PDF-Versionen dieser Handbücher werden 
automatisch mit Pro Tools LE installiert. Über 
das Help-Menü in Pro Tools LE können Sie 
bequem darauf zugreifen. Um die Handbücher 
online zu lesen oder auszudrucken, müssen Sie 
den Acrobat Reader installieren (auf der 
Pro Tools LE-Installations-CD enthalten).



                    
Konventionen in diesem Handbuch

In den Digidesign-Handbüchern werden für 
Menüoptionen und Tastaturbefehle die 
folgenden Konventionen verwendet:

Durch folgende Symbole werden besonders 
wichtige Informationen hervorgehoben:
.

Konvention Aktion

File > Save 
Session

Wählen Sie im File-Menü die Save 
Session-Option aus.

Control + N Betätigen Sie bei gedrückter 
Control-Taste die N-Taste.

Klicken Sie 
bei 
gedrückter 
Option-Taste

Klicken Sie bei gedrückter Option-
Taste.

Rechtsklicken 
Sie (Windows)

Klicken Sie mit der rechten 
Maustaste.

Benutzertipps sind nützliche Hinweise für 
eine optimale Nutzung Ihres Systems.

Wichtige Hinweise enthalten 
Informationen, die sich auf die Daten oder 
auf die Leistung Ihres Systems beziehen.

Querverweise verweisen auf 
themenverwandte Abschnitte in anderen 
Digidesign-Handbüchern.
Wählen und Auswählen

Normalerweise haben die Wörter „wählen“ und 
„auswählen“ im Deutschen die gleiche 
Bedeutung. In diesem Handbuch wird jedoch 
zwischen beiden Begriffen wie folgt 
unterschieden:

Auswählen Wenn Sie in diesem Handbuch 
aufgefordert werden, etwas auszuwählen, bleibt 
es ausgewählt. Das ist der Fall bei Dialogfeld- 
und Menü-Optionen, die etwas aktivieren oder 
deaktivieren.

Wählen Wenn Sie in diesem Handbuch 
aufgefordert werden, etwas zu wählen, wird ein 
einmaliger Vorgang ausgeführt. Das ist bei den 
meisten Menübefehlen der Fall.

Digidesign-Registrierung
Füllen Sie bitte die beiliegende 
Registrierungskarte für die Mbox aus, und 
schicken Sie sie an uns zurück. Registrierte 
Benutzer erhalten 90 Tage lang kostenlosen 
technischen Kundendienst, der beim ersten 
Anfruf bei Digidesign Tech Support aktiviert 
wird.
Kapitel 1: Mbox Einführung 5
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Kapitel 2

Macintosh-Konfiguration
Installieren der Pro Tools LE-
Software
Bevor Sie Pro Tools LE installieren können, 
müssen Sie erst den Computer und die Apple-
Systemeinstellungen konfigurieren. 
Erforderliche Vorgänge:

• Konfigurieren Sie die Apple-
Systemeinstellungen. Siehe „Einstellungen 
der Apple-Systemsoftware“ auf Seite 7.

• Installieren Sie Pro Tools LE. Siehe 
„Installieren von Pro Tools LE“ auf Seite 8.

• Starten Sie den Computer neu.

• Schließen Sie die Mbox am Computer an. 
Siehe „Anschließen der Mbox an einem 
Computer“ auf Seite 12.

• Nehmen Sie die Audio-Anschlüsse vor. Siehe 
„Herstellen von Signalverbindungen zur 
Mbox“ auf Seite 18.

Einstellungen der Apple-
Systemsoftware

Damit Pro Tools LE optimal funktioniert, 
müssen Sie die Apple-Systemeinstellungen 
folgendermaßen konfigurieren.

So konfigurieren Sie die Apple-Systemsoftware:

1  Nehmen Sie im Kontrollfeld Speicher 
(Memory) die folgenden Einstellungen vor:
• Klicken Sie im Abschnitt Virtueller 
Speicher (Virtual Memory) auf die 
Schaltfläche Aus (Off).

• Klicken Sie im Abschnitt RAM-Diskette 
(RAM Disk) auf die Schaltfläche Aus (Off).

• Setzen Sie den Festplatten-Cache (Disk 
Cache) auf den benutzerdefinierten Wert 
von 512 K.

2  Setzen Sie im Kontrollfeld Energie sparen 
(Energy Saver) die „Inaktivität“ auf Nie (Never). 

3  Wenn Sie die Software auf einem Macintosh 
PowerBook installieren, klicken Sie im 
Kontrollfeld Energie sparen auf Erweiterte 
Optionen und vergewissern Sie sich, dass die 
Option zum Ausschalten des Prozessors 
deaktiviert ist.

4  Nehmen Sie im Kontrollfeld Erscheinungsbild 
(Appearance) die folgenden Einstellungen vor:

• Klicken Sie auf das Register Zeichensätze 
(Fonts) und wählen Sie als Großen 
Systemzeichensatz die Option Chicago. 
Deaktivieren Sie außerdem die Funktion 
Zeichensätze glätten (Smooth all fonts on 
screen).

• Klicken Sie auf das Register Ton (Sound) und 
wählen Sie im Popup-Menü Toneffekte 
(Sound Track) den Eintrag Keine (None).

5  Nehmen Sie im Kontrollfeld Erweiterungen 
Ein/Aus (Extensions Manager) die folgenden 
Einstellungen vor:
Kapitel 2: Macintosh-Konfiguration 7
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• Wählen Sie im Popup-Menü Ausgewählte 
Konfiguration (Selected Set) Mac OS 9.1 
Standard (oder Mac OS 9.2 Standard oder 
9.2.2 Standard).

6  Klicken Sie auf Neustart (Restart), um den 
Computer neu zu starten.

Installieren von Pro Tools LE

Wenn Sie die Apple-Systemeinstellungen 
konfiguriert haben, installieren Sie 
Pro Tools LE.

So installieren Sie Pro Tools LE auf dem 
Macintosh: 

1  Legen Sie die Pro Tools LE-Installations-CD in 
das CD- oder entsprechende optische Laufwerk 
ein. Doppelklicken Sie auf „Install Mbox 
Pro Tools LE“.

Sie benötigen zum Ausführen von Pro Tools 
OS 9.1 oder höher.

Kontrollfeld Erweiterungen Ein/Aus (Extension 
Manager)
Erste Schritte mit Mbox
2  Folgen Sie den Installationsanweisungen auf 
dem Bildschirm.

3  Wählen Sie nun im Install-Fenster die 
Festplatte aus, auf der sich der Systemordner 
befindet und aktivieren Sie die 
Installationsoption für Pro Tools LE  5.2 für 
Mbox. 

4  Wenn Sie die Mbox zum Ausgeben von 
Systemtönen verwenden wollen, wählen Sie das 
Digidesign Sound-Kontrollfeld aus.

5  Klicken Sie auf Install und folgen Sie den 
Anweisungen auf dem Bildschirm.

6  Wählen Sie den Ordner für den Web-Browser 
und klicken Sie auf OK.

7  Klicken Sie nach dem Abschluss der 
Installation auf Quit und installieren Sie OMS 
(siehe “Installieren und Konfigurieren von 
OMS“ auf Seite 9), falls dies noch nicht 
geschehen ist.

8  Klicken Sie auf Restart

- oder -

Klicken Sie auf Quit und installieren Sie eine der 
optionalen Demo-Sessions (siehe “Installieren 
der Demo-Sessions (optional)“ auf Seite 9).

Informationen zu DigiStudio-
Komponenten

Bei der Installation von Pro Tools LE 5.2 wird 
der DigiStudio-Ordner im Pro Tools-Ordner 
erstellt. Dieser Ordner enthält Bibliotheken und 
Dateien, die zum Einsatz von Pro Tools mit 
DigiStudio erforderlich sind sowie Digi Studio 

Pro Tools muss das Rocket Plug-In für den 
Web-Browser installieren. Wählen Sie den 
Plug-In-Ordner für den Web-Browser aus, 
wenn Sie dazu aufgefordert werden.



                           
Control. Diese Komponenten sind zum 
Ausführen von Pro Tools nicht erforderlich. 
Weitere Informationen hierzu finden Sie im 
DigiStudio Guide.

Installieren der Demo-Sessions 
(optional)

Die Pro Tools LE-Installations-CD enthält zwei 
Demo-Sessions, mit denen Sie die Hardware- 
und Software-Installationen testen können: 

• Pro Tools SoundCheck ist eine einfache 
Pro Tools-Session, mit der Sie die 
einwandfreie Funktion des Systems testen 
können.

• Be There for MBox ist ein umfangreicherer 
Demo-Song, mit dem Sie die 
Systemwiedergabe testen und einige der 
Grundfunktionen von Pro Tools erlernen 
können.

So installieren Sie die Demo-Sessions:

1  Legen Sie die Pro Tools LE-Installations-CD in 
das CD- oder entsprechende optische Laufwerk 
ein. Doppelklicken Sie auf „Install PT LE Demo 
Session“.

2  Vergewissern Sie sich, dass auf dem 
Installationsbildschirm die Optionen für „Be 
There Session“ und „Sound Check Session“ 
ausgewählt sind.

3  Wählen Sie als Installationsort das 
Audiolaufwerk aus und klicken Sie auf Install.

DigiStudio-Komponenten
4  Klicken Sie nach Abschluss der Installation auf 
Quit.

Installieren und Konfigurieren 
von OMS
Damit Sie auf dem Macintosh mit Pro Tools 
arbeiten können, müssen Sie zunächst das Open 
Music System (OMS) installieren und 
konfigurieren. OMS ist auf der Pro Tools-
Installations-CD enthalten und hat folgende 
Funktionen:

• Es speichert Informationen darüber, welche 
MIDI-Geräte Sie verwenden, wie diese Geräte 
angeschlossen sind und welche Patches 
verwendet werden.

• Es ermöglicht die Kommunikation der MIDI-
Hardware mit Musikanwendungen.

• Es erfüllt Timing-Funktionen und 
gewährleistet die Kommunikation zwischen 
den einzelnen Anwendungen.

OMS speichert eine Beschreibung aller MIDI-
Geräte im Studio in sogenannten Studio Setup-
Dokumenten, die in der AnwendungOMS Setup 
bearbeitet werden können. Sobald OMS 
konfiguriert ist, wissen alle 
Musikanwendungen, welche MIDI-Geräte Sie 
verwenden, indem sie das aktuelle Studio Setup-
Dokument als Referenz nutzen.

Sie benötigen zum Erstellen eines Studio-Setup 
keine MIDI-Interface oder -Geräte. Zum 
Ausführen von Pro Tools LE mit Mbox ist 
lediglich ein konfiguriertes OMS-Studio-Setup 
erforderlich, unabhängig davon, ob MIDI-
Geräte angeschlossen sind oder nicht.
Kapitel 2: Macintosh-Konfiguration 9
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Die folgenden Abschnitte enthalten 
grundlegende Anleitungen zur Installation und 
Konfiguration von OMS. Ausführlichere 
Informationen finden Sie im Online-OMS Guide, 
das mit Pro Tools installiert wird.

Installieren von OMS

Der OMS Installer befindet sich auf der 
Pro Tools-Installations-CD.

So installieren Sie OMS:

1  Legen Sie die Pro Tools-Installations-CD in das 
CD- oder entsprechende optische Laufwerk ein. 

2  Öffnen Sie den OMS Installer-Ordner und 
doppelklicken Sie auf OMS Installer.

3  Wählen Sie nun im Install-Fenster die 
Festplatte aus, auf der sich der Systemordner 
befindet und aktivieren Sie die Easy Install-
Option. Klicken Sie auf Install.

4  Folgen Sie den Installationsanweisungen auf 
dem Bildschirm.

5  Starten Sie nach Abschluss der Installation 
den Macintosh neu.

Konfigurieren eines neuen Studio-
Setups
(nur bei erstmaliger Benutzung von OMS)

Vergewissern Sie sich vor der Konfiguration von 
OMS, dass evtl. vorhandene MIDI-Interfaces 
entsprechend den Anweisungen des Herstellers 
angeschlossen und eingeschaltet sind.

So konfigurieren Sie ein neues Studio-Setup in 
OMS:

1  Starten Sie die OMS Setup-Anwendung. Wenn 
OMS noch nicht konfiguriert wurde, werden Sie 
zur Konfiguration eines neuen Studio-Setups 
aufgefordert. Klicken Sie auf OK.
Erste Schritte mit Mbox
2  Klicken Sie auf OK, um nach MIDI-Geräten zu 
suchen, die an Ihr MIDI-Interface angeschlossen 
sind. Damit das Gerät erkannt wird, muss es 
eingeschaltet und über beide MIDI-Ports an Ihr 
MIDI-Interface angeschlossen sein.

OMS sucht nach allen erkannten MIDI-Geräten 
und OMS-Treibern. Einige ältere sowie einige 
der neueren Instrumente werden 
möglicherweise nicht von den OMS-
Suchroutinen erkannt.

Aktivieren Sie keines der beiden 
Kontrollkästchen, wenn Sie ein USB-, 
Firewire- oder PCI-MIDI-Interface verwenden 
oder wenn kein Interface bzw. Gerät 
angeschlossen ist.

Auswählen der Ports für die Suche nach OMS-Treibern 
und zeigt diese an

Einrichten des OMS-Treibers



                       
Wurde Ihr Interface nicht erkannt, klicken Sie 
auf Troubleshoot. Wurde Ihr Interface erkannt, 
werden Sie dazu aufgefordert, nach den daran 
angeschlossenen MIDI-Instrumenten zu 
suchen.

Geräte, die nicht von OMS erkannt wurden, 
erscheinen mit einem roten Fragezeichen und 
werden entsprechend dem Interface oder Port 
benannt, an das/den sie angeschlossen sind. 
Diese Geräte können in der OMS Setup-
Anwendung definiert werden (siehe “Definieren 
von MIDI-Geräten in OMS“ auf Seite 11).

3  Klicken Sie auf OK, um das Studio Setup-
Dokument zu speichern.

Deaktivieren von Serial DMA in 
OMS

Für den Betrieb von Pro Tools ist es erforderlich, 
dass Sie in der OMS Setup-Anwendung die 
Option Use Apple Serial DMA Driver When 
Available deaktivieren. Wenn Sie diese Option 
nicht deaktivieren, treten in Pro Tools Probleme 
bei MIDI- und Synchronisationsfunktionen auf.

So deaktivieren Sie Serial DMA in OMS:

1  Doppelklicken Sie auf die OMS Setup-
Anwendung.

2  Wählen Sie Edit > Preferences.

3  Deaktivieren Sie Use Apple Serial DMA Driver 
When Available und klicken Sie auf OK. 

4  Beenden Sie OMS Setup.

Nicht definiertes OMS-Gerät
Definieren von MIDI-Geräten in 
OMS

Sie müssen evtl. vorhandene MIDI-Geräte in 
OMS definieren, damit Pro Tools sie erkennen 
kann.

So definieren Sie ein MIDI-Gerät in der OMS Setup-
Anwendung:

1  Doppelklicken Sie im Studio Setup-Fenster auf 
das Symbol für das gewünschte Gerät.

2  Wählen Sie im MIDI Device Info-Dialogfeld 
im Manufacture-Popup-Menü den Hersteller 
und im Model-Popup-Menü das Modell des 
Geräts aus. Ist das Gerät nicht aufgeführt, 
belassen Sie im Model-Popup-Menü den Eintrag 
„other“ und geben Sie einen Namen für das 
Gerät ein.

3  Wählen Sie den Empfangskanal für das Gerät 
aus. Wenn mehrere Kanäle empfangen werden, 
wählen Sie die Is Multitimbral-Option aus.

4  Wenn Sie von diesem Gerät Material in 
Pro Tools aufnehmen möchten, wählen Sie die 
Is Controller-Option aus. Wenn das Gerät MIDI-
Timecode, Beat Clock-Signale oder MIDI-
Maschinensteuerungssignale ausgeben oder 
empfangen soll, aktivieren Sie die 
entsprechende Option.

5  Klicken Sie auf OK.

MIDI Device Info-Dialogfeld
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Erstmaliges Starten von 
Pro Tools LE
Eingeben der Seriennummer

Wenn Sie Pro Tools LE zum ersten Mal starten, 
werden Sie aufgefordert, eine Seriennummer 
einzugeben.

Die Seriennummer befindet sich auf der inneren 
Umschlagseite dieses Handbuchs. Geben Sie die 
Seriennummer in das entsprechende Dialogfeld 
ein und achten Sie dabei auf die korrekte 
Eingabe von Leerzeichen sowie Groß- und 
Kleinbuchstaben. Klicken Sie anschließend auf 
Validate.

Wenn Sie DigiStudio zur Online-Arbeit mit 
anderen Benutzern nutzen wollen, lesen Sie das 
DigiStudio-Handbuch, nachdem Sie die 
Installation von Pro Tools LE und der Mbox 
bestätigt haben. Das DigiStudio-Handbuch 
beschreibt das Installieren, Konfigurieren sowie 
den Einsatz von DigiStudio.

Eingeben der Pro Tools-Seriennummer
Erste Schritte mit Mbox
Anschließen der Mbox an 
einem Computer
Nachdem Sie Pro Tools LE installiert haben, 
können Sie die Mbox am Computer 
anschließen.

So schließen Sie die Mbox am Macintosh an:

1  Schließen Sie ein Ende des USB-Kabels am 
USB-Port der Mbox an.

2  Schließen Sie das andere Ende des USB-Kabels 
an einer freien USB-Schnittstelle des Computers 
an.

Die Mbox funktioniert nicht 
ordnungsgemäß, wenn sie an einem USB-
Hub angeschlossen wird. Die Mbox muss 
direkt an einer USB-Schnittstelle 
angeschlossen werden. Wenn Sie weitere 
USB-Geräte an einem Hub anschließen 
wollen, müssen Sie den Hub an einer 
anderen Schnittstelle anschließen.



Kapitel 3

Verkabelung des Studios
In diesem Kapitel wird erklärt, wie Sie die Mbox 
an verschiedenen Eingangsquellen und 
Abhörsystemen anschließen.
Funktionen an der Vorderseite 
der Mbox

Die Vorderseite der Mbox hat folgende 
Funktionen:

Abbildung 1.  Die Vorderseite der Mbox
Kapitel 3: Verkabelung des Studios 13
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48V-LED

Wenn diese LED leuchtet, ist die 48 V-
Phantomspeisung an den Mic/Line-Eingängen 
aktiv. Diese Eingänge stellen Phantomspeisung 
für Mikrofone zur Verfügung, falls dies 
erforderlich ist. Sie können die 
Phantomspeisung mit dem 48V-Schalter oben 
auf der Rückseite der Mbox aktivieren.

Phantomspeisung

Für dynamische Mikrofone (z.B. Shure SM57) 
wird die Phantomspeisung zwar nicht benötigt, 
sie hat jedoch auf diese auch keine schädigende 
Wirkung. Die meisten Kondensatormikrofone 
hingegen (z.B. AKG C300) benötigen 
Phantomspeisung zum Betrieb. Wenn Sie nicht 
sicher sind, ob Ihr Mikrofon Phantomspeisung 
benötigt oder nicht, wenden Sie sich an den 
jeweiligen Hersteller oder schlagen Sie im 
Handbuch zum Mikrofon nach.

Source-Wahlschalter

Mit diesen Schaltern können Sie einen von drei 
Eingabepegeltypen für die analogen 
XLR/Klinken-Mikrofon/Line-Eingänge 
auswählen: Mic (Mikrofon), Line und Inst 
(Instrument).

Obwohl Phantomspeisung für die meisten 
Mikrofontypen unschädlich ist, können 
Bändchenmikrofone beschädigt werden. 
Deaktivieren Sie die Phantomspeisung 
daher auf jeden Fall und warten Sie 
mindestens zehn Sekunden lang, bis Sie ein 
Bändchenmikrofon anschließen bzw. 
entfernen.
Erste Schritte mit Mbox
Gain-Regler

Mit diesen Reglern können Sie die 
Empfindlichkeit der Mikrofon-/Line-Eingänge 
einstellen.

Peak-LEDs

Diese LEDs werden knapp unterhalb des 
analogen Übersteuerungspegels aktiviert. Falls 
die Peak-LEDs gelegentlich flackern, hat das 
Signal fast den Übersteuerungspegel erreicht, 
was aber nicht unbedingt zu Verzerrungen oder 
Übersteuerungen führen muss.

USB-LED

Die USB-LED zeigt an, dass der Digidesign-USB-
Treiber die Mbox am USB-Bus erkannt und den 
entsprechenden Treiber geladen hat. Leuchtet 
die USB-LED, können Audiosignale ein- und 
ausgegeben werden. Siehe „Beheben von 
Fehlern mit dem USB-Anschluss“ auf Seite 21.

S/PDIF-LED

Diese LED zeigt an, dass Kanal 1 und 2 auf den 
Empfang digitaler Eingangssignale eingestellt 
sind. Siehe „Digitaler S/PDIF-Eingang/Ausgang“ 
auf Seite 17.

Mix (Verhältnis)-Regler

Mit der Mbox können Sie die Eingangssignale 
ohne die Verzögerung, die durch A/D/A-
Wandler und Host-Processing erzeugt wird, 
während der Aufnahme abhören. 

Sie können das latenzfreie Abhören mit dem 
Mix-Regler steuern und das Abhörverhältnis 
zwischen dem Mbox-Eingang und Pro Tools-
Wiedergabe mischen und anpassen. Wenn Sie 
nur das Quelleingangssignal hören möchten, 



drehen Sie den Mix-Regler ganz nach links auf 
Input. Wenn Sie nur die Pro Tools-Ausgabe 
hören möchten, drehen Sie den Regler ganz 
nach rechts auf Playback.

Die Ausgabe vom Mix-Regler wird direkt an die 
Klinken-Line-Ausgänge sowie den Headphone- 
und den S/PDIF-Ausgang geroutet.

Diese Möglichkeit, die relativen Pegel von Pro 
Tools-Wiedergabe und latenzfreien Live-
Eingängen zu mischen und anzupassen, kann 
beim Overdubbing oder anderweitigem 
Eingeben von Audio durch die 
Mikrofonvorverstärker oder digitalen Eingänge 
der Mbox besonders effektiv sein. 

Eine weitere nützliche Funktion (besonders 
beim Overdubbing) ist der Mono-Schalter.

Mono-Schalter

Der Mono-Schalter addiert und zentriert die 
abgehörten Eingangssignale, hat aber keinen 
Einfluss auf das Abhören der Pro Tools-
Wiedergabe. 

Die Funktion zum Zentrieren von 
Eingangssignalen (im Gegensatz zum Abhören 
der Signale ganz links und rechts in den 
Kopfhörerausgängen) ermöglicht das Erstellen 
einer effektiven und konzentierten 
Abhörmischung. Zusammen mit der 
latenzfreien Eingangsabhörung dient der Mono-
Schalter zum Ausgleichen von herkömmlichen 
Störungen (z.B. die Zeitverzögerung durch 
Latenz und die Ablenkungen schlechter 
regelbarer Abhörmischungen), die Musikern 
und Technikern seit jeher Schwierigkeiten 
bereiten.
Es gibt natürlich viele Situationen, in denen der 
Mono-Schalter nützlich ist. Stereo-Mikrofone 
und -Synthesizer sowie Quellenpaare mit einer 
bequemen Balance sind Beispiele für 
Eingangsquellen, die wahrscheinlich bei 
deaktivierten Mono-Schalter besser klingen. 

Prüfen von Phasenbeziehungen

Mit dem Mono-Schalter können Sie auch 
schnell die Phasenbeziehung zwischen den 
Eingängen Source 1 und Source 2 prüfen. Sind 
die beiden Eingangssignale phasenverschoben, 
tritt üblicherweise ein deutlicher Verlust an 
Niederfrequenzenergie auf, wenn diese Signale 
kombiniert werden. 

Sind die beiden Eingangssignale 
phasenverschoben und Sie drücken den Mono-
Schalter, entsteht ein plötzlicher „hohler“ Ton, 
der durch die Phasenauslöschung erzeugt wird. 
Dieser schnelle Test mit dem Mono-Schalter 
kann bei der Vermeidung von 
Phasenproblemen beim Mischen dieser Spuren 
hilfreich sein. Ein regelmäßiges Prüfen der 
Phasenbeziehungen mit dem Mono-Schalter 
kann auch zum Erkennen der optimale 
Mikrofonpositionierung behilflich sein.

Headphone-Regler

Mit diesem Regler können Sie den Ausgabepegel 
der vorderen und hinteren Headphone-Ports 
anpassen, die das Signal ausgeben, das auf die 
Analog Outputs 1–2 in Pro Tools LE und die 
Line-Ausgänge geroutet wird.
Kapitel 3: Verkabelung des Studios 15
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Kopfhörerausgang auf der 
Gerätevorderseite

Sie können Stereokopfhörer am 
Kopfhörerausgang an der Gerätevorderseite 
über einen 3,5 mm-Stereo-Ministecker 
anschließen. 

Wird ein 6,3 mm-Klinkenstecker am 
Kopfhörerausgang an der Geräterückseite 
angeschlossen, ist der 3,5 mm-
Kopfhörerausgang an der Vorderseite 
deaktiviert. 

Funktionen an der Rückseite 
der Mbox

Abbildung 2.  Die Rückseite der Mbox
Erste Schritte mit Mbox
Die Rückseite der Mbox hat folgende 
Funktionen:

Kopfhörerausgang an der 
Geräterückseite

Sie können Stereokopfhörer an diesem 
Kopfhörerausgang über einen 6,3 mm-
Klinkenstereostecker anschließen. 

Wird ein 6,3 mm-Klinkenstecker am 
Kopfhörerausgang an der Geräterückseite 
angeschlossen, ist der 3,5 mm-
Kopfhörerausgang an der Vorderseite 
deaktiviert. 

48V-Schalter

Diese Taste aktiviert die Phantomspeisung der 
Mic-Eingänge für Mikrofone, die diese zum 
Betrieb benötigen. 

USB-Port

Über diesen standardmäßigen USB-Port wird die 
Mbox am Computer angeschlossen. Ein 
herkömmliches USB-Kabel ist im Lieferumfang 
des Systems enthalten. 

Prüfen Sie, ob die 48V-LED an der 
Vorderseite der Mbox leuchtet, bevor Sie ein 
Mikrofon anschließen. Der 48V-Schalter 
befindet sich auf der Rückseite direkt über 
dem USB-Anschluss und könnte 
versehentlich ungewollt beim Anschließen 
des USB-Kabels betätigt werden.



Digitaler S/PDIF-
Eingang/Ausgang

Die S/PDIF-Ein- und Ausgänge sind als 
unsymmetrische Phono-Cinchbuchsen 
ausgelegt, die einen digitalen Datenstrom auf 
zwei Kanälen mit 24 Bit übertragen.

Das Sony/Philips Digital Interface Format 
(S/PDIF) kommt in vielen professionellen und 
semi-professionellen CD-Spielern und DAT-
Rekordern zum Einsatz. Um elektromagnetische 
Einstreuungen zu vermeiden, sollten Sie ein 75-
Ohm-Koaxialkabel mit einer Länge von 
maximal 10 Metern verwenden.

Line-Ausgänge

Bei den Anschlüssen handelt es sich um 
symmetrische Klinkenbuchsen.An diese 
Ausgänge können ein Mischpult, ein 
Abhörsystem (z.B. ein Stereoverstärker) oder ein 
anderes Stereoziel zum Abhören der Mischung 
angeschlossen werden. 

Die Line Outputs 1 und 2 geben die 
Audiosignale aus, die auf die Analog Outputs 1 
und 2 in Pro Tools geroutet wurden. Diese 
analogen Ausgänge sind mit 24-Bit-
Digital/Analog-Wandlern ausgestattet.

Source 1 und 2

Diese symmetrischen/unsymmetrischen 
Eingänge unterstützen eine Vielzahl von 
Eingangspegeln (z.B. Mikrofone, Instrumente 
oder Line-Signale). Es können XLR-, Klinken- 
oder TS-Audio-Stecker angeschlossen werden. 
Das Eingangssignal wird mit dem Gain-Regler 
für jeden Kanal sowie dem Source-Schalter 
angepasst. 
Inserts 1 und 2

Die Mbox stellt für jeden Eingangskanal einen 
Insert-Punkt zur Verfügung. Diese 
Klinkenanschlüsse senden und empfangen das 
Signal des Eingangskanals direkt nach dem 
Vorverstärker und vor dem A/D-Wandler. Dies 
ermöglicht das Einfügen von analogen 
Prozessoren (z.B. Kompressoren oder Equalizer), 
die üblicherweise als Inserts bei herkömmlichen 
analogen Aufnahmekonsolen genutzt werden. 
Siehe „Analoge Inserts am Eingang“ auf 
Seite 19.

Die XLR-Anschlüsse unterstützen nur 
Mikrofoneingänge (d.h. wenn Line oder Inst 
gewählt wird, wird der XLR-Anteil des 
Anschlusses ignoriert). Wenn Sie mic 
wählen, wird der 3,5 mm-Anteil des 
Anschlusses ignoriert. Dies liegt an der 
Impedanzeinstellung für die jeweiligen 
Anschlusstypen.
Kapitel 3: Verkabelung des Studios 17
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Herstellen von 
Signalverbindungen zur Mbox
Sie können die Mbox in einer Reihe von Audio-
Setups verwenden. In diesem Abschnitt wird 
beschrieben, wie Sie grundlegende 
Verbindungen für folgende Aufgaben herstellen 
können:

• Abhören

• Aufnehmen

• Eingabe für Aufnahme

• Abmischen

• Hardware-Inserts

Abhören von Audio

Es stehen zwei Kopfhöreranschlüsse zur 
Verfügung: ein 6,3 mm-Klinkenanschluss an der 
Rückseite und ein 3,5 mm-Anschluss an der 
Gerätevorderseite.

Die Line-Ausgänge der Mbox geben die 
Audiosignale wieder, die in Pro Tools auf Analog 
Outputs 1–2 geroutet sind, und können Links- 
und Rechts-Ausgänge zum Abmischen für ein 
zweispuriges Deck oder ein anderes Stereoziel 
zur Verfügung stellen. 

Diese Line-Ausgänge sind mit 24-Bit-
Digital/Analog-Wandlern mit einer maximalen 
Ausgabe von +4 dBu ausgestattet. Als Anschlüsse 
werden Klinkenstecker oder unsymmetrische 
TS-Stecker unterstützt.

So schließen Sie einen Kopfhörer an:

1  Schließen Sie den Kopfhörer an der 
Headphone-Buchse der Mbox an. Der Ausgang 
an der Gerätevorderseite ist für 3,5 mm-, der auf 
der Rückseite für Stereo-Klinkenstecker 
ausgelegt. 
Erste Schritte mit Mbox
2  Passen Sie die Lautstärke für den Kopfhörer 
mit dem entsprechenden Regler an.

So schließen Sie eine Stereoanlage an:

■ Verbinden Sie über 6,3 mm-Kabel die Line-
Ausgänge auf der Geräterückseite mit den 
entsprechenden Eingängen der Stereoanlage. 

So schließen Sie Abhörlautsprecher mit 
Verstärker bzw. aktive Abhörlautsprecher an:

■ Verbinden Sie über 6,3 mm-Kabel die Line-
Ausgänge auf der Geräterückseite mit den 
entsprechenden Eingängen des Mischpults, 
Verstärkers oder der Aktivlautsprecher. 

Der Kopfhörerausgang der Mbox kann sehr 
hohe Ausgangspegel erzeugen. Das Abhören 
bei hoher Lautstärke über längere 
Zeiträume kann Ihr Gehör ernsthaft 
schädigen. Bedenken Sie dies beim 
Einstellen der Kopfhörerlautstärke.

Der Klinken-Kopfhörerausgang an der 
Geräterückseite deaktiviert den 3,5 mm-
Ausgang an der Vorderseite, wenn ein 6,3 
mm-Klinkenstecker angeschlossen wird.

Heimstereoanlagen sind oft mit 
Cinchbuchsen ausgestattet. Sie können 
dann einen TRS/TS-Cinch-Adapter bzw. ein 
entsprechendes Kabel verwenden.



Anschließen von Audioquellen an 
der Mbox

Sie können digitale und analoge Audioquellen 
direkt an der Mbox anschließen.

Analoge Audioquellen

Analoge Audiosignale werden von Mikrofonen, 
Synthesizern, Mischpulten und Instrumenten 
mit Magnettonabnehmern ausgegeben. Von 
diesen Zuspielquellen erzeugen Mikrofone und 
Instrumente mit Magnettonabnehmern die 
leisesten Signale, weshalb für diese in der Regel 
mehr Verstärkung benötigt wird. 

Keyboards, Vorverstärker und Mischpulte 
erzeugen Ausgangssignale mit „Linepegel“. 
Dieser liegt je nach Gerät bei -10 dBV oder +4 
dBu. 

Die Mbox stellt zur Aufnahme der 
unterschiedlichen Quellen umschaltbare 
Impedanz und Eingangspegel mit anpassbarer 
Empfindlichkeit für jeden Eingangskanal zur 
Verfügung.

So schließen Sie eine analoge Audioquelle an:

1  Schließen Sie XLR- oder Klinkenkabel direkt 
am Mic/Line-Eingang 1 oder 2 der Mbox an. 
Diese Eingänge sind sowohl für XLR-Stecker als 
auch für Klinkenstecker ausgelegt. 

2  Drücken Sie die Source-Taste für jeden Kanal 
so oft, bis die LED für die gewünschte Quelle 
leuchtet.

So aktivieren Sie die Phantomspeisung:

■ Falls Ihr Mikrofon Phantomspeisung 
benötigt, vergewissern Sie sich, dass es 
angeschlossen ist, und betätigen Sie den 48V-
Schalter.
Analoge Inserts am Eingang

Die analogen Eingangskanäle an der Mbox sind 
jeweils mit einem Klinken-Insert-Punkt 
ausgestattet. Diese Hardware-Inserts 
unterbrechen den analogen Eingangspfad, 
bevor er in das digitale Format umgewandelt 
und an Pro Tools gesendet wird. Hier können Sie 
einen Kompressor, Equalizer oder ein anderes 
serielles Effektgerät einfügen, das in Reihe mit 
dem Signalpfad geschaltet ist. 

Diese Hardware-Inserts werden gerouted, bevor 
die analogen Eingangssignale in digitale 
umgewandelt werden, und sind nicht zum 
Einfügen auf Spuren in einer Pro Tools-Session 
verfügbar.

Obwohl beide üblicherweise zum Routen von 
Effetprozessoren verwendet werden, dürfen 
Inserts nicht mit Aux-Sends und Returns 
verwechselt werden, die z.B. in Pro Tools und 
herkömmlichen Aufnahmekonsolen zur 
Verfügung stehen. Sends und Returns werden 
üblicherweise für Umgebungs- oder 
Raumeffekte genutzt, die parallel mit dem 
ursprünglichen Signal eingemischt werden. 
Inserts unterbrechen den Signalpfad und 
empfangen lediglich die Ausgabe des seriellen 
Effektgeräts.

Zum Einfügen eines Geräts benötigen Sie ein 
Klinken-Insert-Kabel mit einem Klinkenstecker 
an einem Ende, der zwei unsymmetrische 
Anschlüsse hat. Der Anschluss, der die Spitze 
erhält, ist das Send, der Anschluss, der den Ring 
erhält, ist das Return. 

Wenn Sie die Phantomspeisung aktivieren, 
werden 48 V an beiden Mic-Eingängen 
angelegt. 
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So fügen Sie ein Gerät in den Signalpfad ein:

1  Sie benötigen ein Kabel, dass den 
Klinkenstecker an einem Ende in zwei 
unsymmetrische Anschlüsse aufteilt. Der Typ 
des unsymmetrischen Anschlusses wird von den 
Eingängen des Geräts bestimmt.

2  Bestimmen Sie, welcher unsymmetrischer 
Anschluss Spitze und welcher Ring entspricht. 

3  Verbinden Sie den unsymmetrischen 
Anschluss (Spitze) mit dem Eingang des Geräts.

4  Verbinden Sie den unsymmetrischen 
Anschluss (Ring) mit dem Ausgang des Geräts.

5  Schließen Sie den Klinkenstecker an der 
gewünschten Insert-Buchse der Mbox an.

Digitale Audioquellen

Digitales Audiomaterial stellt analoge 
Wellenformen durch tausende von Stichproben 
(Samples) dar, die jede Sekunde durch Abtasten 
der analogen Wellenform genommen werden. 
Audiomaterial aus einer Pro Tools LE-Session, 
das auf der Festplatte gespeichert wurde, liegt im 
digitalen Format vor.

Die Mbox verfügt über digitale Ein- und 
Ausgänge für Audiosignale im S/PDIF-Format. 

S/PDIF

Viele DAT-Rekorder, CD-Spieler und andere 
digitale Geräte verfügen über Eingänge und 
Ausgänge im S/PDIF-Format (Sony/Philips 
Digital Interchange Format). Über jeden S/PDIF-
Anschluss können zwei digitale Audiokanäle 
mit einer Auflösung von 24 Bit übertragen 
werden. 
Erste Schritte mit Mbox
So schließen Sie ein S/PDIF-Gerät an der Mbox 
an:

1  Sie benötigen zwei 75 Ohm-Koaxialkabel mit 
Cinch-Steckern an beiden Enden.

2  Verbinden Sie den S/PDIF-Ausgang des Geräts 
mit dem S/PDIF-Eingang der Mbox und den 
S/PDIF-Eingang des Geräts mit dem S/PDIF-
Ausgang der Mbox.

3  Wählen Sie Setups > Hardware Setup und 
wählen Sie die gewünschten Einstellungen im 
Sync Mode- und Ch 1–2 Input-Popup-Menü.

S/PDIF Mirroring-Funktion

Pro Tools LE nutzt die S/PDIF Mirroring-
Funktion, um das an die Line-Ausgänge 1 und 2 
gesendete Audiosignal automatisch auch auf die 
S/PDIF-Ausgänge zu „spiegeln“. Diese Funktion 
ist hilfreich, wenn Sie eine Mischung über die 
Line-Ausgänge abhören und gleichzeitig 
dasselbe Signal mit einem S/PDIF-Gerät 
aufzeichnen möchten.



Anschließen eines Rekorders 
zum Abmischen
Nachdem Sie Sessions in Pro Tools 
aufgenommen und gemischt haben, können Sie 
diese als Abmischung auf einen DAT-Rekorder, 
ein Kassettendeck oder ein anderes 
Stereoaufnahmegerät (zwei Tracks) überspielen.

Anschließen eines analogen Rekorders

Schließen Sie den Rekorder (Kassettendeck oder 
anderes analoges Gerät) an die Line-Ausgänge 
auf der Rückseite der Mbox an. Die Line-
Ausgänge 1 und 2 sollten auf den linken bzw. 
rechten Eingang des Rekorders geroutet werden. 
Bei diesen Ausgängen handelt es sich um 
Klinkenbuchsen. Wenn der Rekorder mit 
Cinchbuchsen ausgestattet ist, benötigen Sie 
zum Anschluss ein Adapterkabel.

Anschließen eines digitalen Rekorders

Wenn Sie über einen DAT- oder ein anderes 
Gerät mit S/PDIF verfügen, schließen Sie es an 
den S/PDIF-Ein- bzw. -Ausgängen (Cinch) auf 
der Rückseite der Mbox an.

Wenn Sie einen Tascam DA30 DAT-
Rekorder anschließen möchten, müssen Sie 
das S/PDIF I/O-Format in Pro Tools LE 
einstellen.
Beheben von Fehlern mit dem 
USB-Anschluss
Leuchtet die USB-LED nicht, wenn Sie die Mbox 
einstecken, und Sie sich sicher sind, dass der 
Digidesign USB-Treiber im Erweiterungsordner 
liegt, ziehen Sie das USB-Kabel von der Mbox ab 
und schließen Sie es wieder an. 

4  Leuchtet die USB-LED immer noch nicht, 
schalten Sie den Computer ganz aus, entfernen 
Sie die Mbox und schalten Sie den Computer 
wieder ein. Schließen Sie die Mbox wieder an, 
wenn das OS vollständig gestartet wurde.
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 Erste Schritte mit Mbox



Kapitel 4

Arbeiten mit Pro Tools
Dieses Kapitel beschreibt die wichtigsten 
Dialogfelder und Funktionen von Pro Tools. 
Außerdem werden die Grundlagen der 
Audioaufnahme schrittweise erläutert (siehe 
“Grundlegendes zum Aufnehmen“ auf 
Seite 35). 

Informationen zu diesem Kapitel

Wenn Sie Pro Tools noch nicht kennen, finden 
Sie in diesem Kapitel einen Überblick über das 
Aufnehmen, Editieren, Automatisieren und 
Mischen mit Pro Tools. 

Die in diesem Kapitel erwähnten Funktionen 
werden ausführlich im Pro Tools 
Referenzhandbuch beschrieben, das Sie von Pro 
Tools aus aufrufen können, indem Sie Help > 
Pro Tools Reference Guide wählen. In diesem 
Handbuch finden Sie zusätzliche Informationen 
zu allen Pro Tools-Funktionen. 
Grundlegendes zu Sessions
Pro Tools-Projekte werden als Sessions erstellt 
und gespeichert. In einer Session werden alle 
Track-, Audio-, MIDI- und andere Session-
Informationen gespeichert. Audio- und Fade-
Dateien werden in Unterordnern des Session-
Ordners gespeichert.

Pro Tools merkt sich die Konfiguration des 
Audio-Interface und anderer 
Systemeinstellungen und wendet diese auf alle 
neuen Sessions an.

Session-Ordner mit der Session-Datei und den 
dazugehörigen Ordnern mit Audio- und Fade-Dateien
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Starten einer Session

So richten Sie eine neue Session ein:

1  Starten Sie Pro Tools.

2  Wählen Sie File > New Session. 

3  Stellen Sie im New Session-Dialogfeld Sample-
Rate, Bittiefe und andere Optionen für die neue 
Session ein.

4  Wählen Sie aus, wo die Session gespeichert 
werden soll. Wenn das Pro Tools-System externe 
Festplatten enthält, vergewissern Sie sich, dass 
sie das richtige Laufwerk im New Session-
Dialogfeld auswählen.

5  Klicken Sie auf Save. In der neuen Session 
werden die Mix-, Edit- and Transport-Fenster 
geöffnet (siehe Abbildung 3 auf Seite 25).

New Session-Dialogfeld
Erste Schritte mit Mbox
Hauptfenster

Die Mix-, Edit- und Transport-Fenster stellen 
den Hauptarbeitsbereich von Pro Tools dar. Sie 
können diese Fenster einblenden, indem Sie den 
entsprechenden Namen im Windows-Menü 
wählen. 

Mix-Fenster Zeigt das Pro Tools-Mischpult mit 
den vertrauten Fader-Zügen für Track-Pegel, 
Pan, Solo, Mute und Signal-Routing. 

Edit-Fenster Zeigt Tracks in der Session entlang 
der Timeline zum Bearbeiten von Audio-, MIDI- 
und Automationsdaten an. 

Transport-Fenster Enthält standardmäßige 
Bedienelemente für Play, Stop, Rewind, Fast 
Forward, Pause und Record. Das Transport-
Fenster kann auch Counter- und MIDI Control-
Anzeigen enthalten.

Session Setup-Fenster Enthält eine 
Statusanzeige für wichtige Pro Tools-Session-
Einstellungen (z.B. Sample-Rate und 
Dateiformat). 

So rufen Sie das Session Setup-Fenster auf:

■ Wählen Sie Windows > Show Session Setup.



Abbildung 3.  Hauptfenster der Session (im Uhrzeigersinn von oben links): Edit-, Mix- und Transport-Fenster

Tracks

Tracks

Rulers

Transport-Fenster
Session-Einstellungen

Pro Tools enthält mehrere verschiedene 
Timebase Rulers zum Auswählen der Timebase 
für die Session. Die Timebase Rulers befinden 
sich am oberen Rand des Edit-Fensters (z.B. 
Bars:Beats und Minutes:Seconds). Die aktuelle 
Timebase bestimmt das Format der Hauptzähler 
und die Basis für das Raster im Edit-Fenster. 

So wählen Sie ein Timebase Ruler aus:

■ Klicken Sie auf den Kreis neben den Anzeigen 
in der oberen linken Ecke des Edit-Fensters (mit 
der Bezeichnung Bars:Beats, Sample usw.).

Speichern von Sessions

Sie sollten den Fortlauf Ihrer Arbeit in der 
Session (Hinzufügen von Tracks, Ändern von 
Session-Parametern usw.) regelmäßig speichern. 
Pro Tools bietet drei Möglichkeiten zum 
Speichern von Sessions mit jeweils 
unterschiedlichen Optionen. 

Sessions werden in der Regel gespeichert, um 
die Daten zu sichern bzw. zu archivieren 
und zur Vorbereitung der Übertragung von 
Projekten. Session-Dateien können 
außerdem gespeichert werden, um Sample-
Raten zu konvertieren oder Session-Vorlagen 
zu erstellen. Session-Vorlagen sind 
Pro Tools-Sessions mit vordefinierten 
Tracks, Routing, Plug-Ins und anderen 
Parametern. Weitere Informationen zum 
Erstellen und Einsetzen von Session-
Vorlagen finden Sie im Pro Tools 
Referenzhandbuch.
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So speichern Sie eine Session:

■ Wählen Sie File > Save Session, Save Session As 
oder Save a Session Copy In. 

Save Session Speichert die aktuelle Session und 
lässt sie geöffnet.

Save Session As  Erstellt eine Kopie der Session-
Datei mit einem von Ihnen gewählten Namen. 
Neue Audio Files- und Fade Files-Ordner werden 
nicht erstellt. Dies ist dann hilfreich, wenn Sie 
mit verschiedenen Einstellungen der Session 
experimentieren wollen, ohne die 
ursprüngliche Session zu verändern.

Save a Session Copy In  Speichert nur die 
Dateien, die in der aktuellen Session genutzt 
werden. Dies ist z.B. für eine letzte Kopie der 
Session hilfreich, die keine Audio-Dateien oder 
Fades enthält, die nicht mehr genutzt werden.

Systemressourcen und 
Einstellungen

Sie können viele Pro Tools-Systemeinstellungen 
im Playback Engine-Dialogfeld zum Optimieren 
der Systemleistung anpassen.

Playback Engine-Dialogfeld

Hier können Sie Puffer und andere 
Systemeinstellungen anpassen.

Playback Engine-Dialogfeld für ein Pro Tools LE-System
Erste Schritte mit Mbox
So konfigurieren Sie die Systemressourcen:

■ Wählen Sie Setup > Playback Engine. Weitere 
Informationen hierzu finden Sie im Pro Tools 
Referenzhandbuch.

System Usage-Fenster

Zeigt Informationen über die CPU- und DSP-
Leistung an. 

So zeigen Sie die Systemressourcen und -nutzung 
an:

■ Wählen Sie Windows > Show System Usage. 

Transport-Bedienelemente
Das Transport-Fenster enthält alle 
Transportbefehle von Pro Tools. Sie können 
verschiedene Transport-Bedienelemente ein- 
bzw. ausblenden, indem Sie sie im Transport 
Window Shows-Untermenü auswählen.

So blenden Sie das Transport-Fenster ein:

■ Wählen Sie Window > Show Transport 
Window. 

Balkenanzeigen im System Usage-Fenster

Transport-Fenster

Online

Rewind

Stop

Play

Record

Return to Zero

Go to End

Fast Forward



So konfigurieren Sie das Transport-Fenster:

■ Wählen Sie Display > Transport Window 
Shows und dann die gewünschte Option. 

In der Standardansicht enthält das Transport-
Fenster Play, Stop und andere standardmäßige 
Transport-Bedienelemente. Das erweiterte 
Transport-Fenster enthält pre- und post-roll, 
Start-, End- und Length-Anzeigen für die 
Timeline-Auswahl sowie den Transport Master 
Selector. Das Transport-Fenster kann auch 
folgende MIDI Control-Anzeigen enthalten: 
Wait for Note, Click, Countoff, MIDI Merge, 
Conductor, Meter und Tempo. 

Tempo

Sie können ein Session-Tempo mit den MIDI-
Tempo-Bedienelementen im erweiterten 
Transport-Fenster oder mit dem Tempo-Ruler 
einstellen. 

So definieren Sie ein Session-Tempo:

■ Klicken Sie im Transport-Fenster in das 
Tempo-Feld und geben Sie das gewünschte 
Tempo ein. 

So geben Sie ein Session-Tempo ein:

1  Wählen Sie Display > Transport Window 
Shows > MIDI Controls. 

2  Deaktivieren Sie in den Transport MIDI 
Controls die Conductor-Option, um den 
Manual Tempo-Modus zu aktivieren. 

Pro Tools beginnt die Wiedergabe an der 
Cursor-Position oder vom Startpunkt der 
aktuellen Selektion. Die Aktuelle Einstellung 
des Link Edit/Timeline-Befehls im 
Operations-Menü wirkt sich auch auf die 
Wiedergabe aus (siehe Pro Tools 
Referenzhandbuch).
3  Drücken Sie die Leertaste, um auf die Tap-
Schaltfläche zu klicken. 

Click und Metronome

Pro Tools enthält eigene MIDI Click-Optionen. 
Sie können diese Funktion über das 
Metronome-Symbol im Transport-Fenster 
aktivieren bzw. deaktivieren und im MIDI Click 
Options-Dialogfeld konfigurieren. 

So konfigurieren und aktivieren Sie den Pro Tools-
Click:

1  Wählen Sie MIDI > Click Options.

2  Konfigurieren Sie die Click-Parameter 
entsprechend der MIDI-Audioquelle. 

3  Sie können die Click-Funktion während der 
Aufnahme oder Wiedergabe mit dem Click-
Schalter in der MIDI Controls-Anzeige des 
Transport-Fensters aktivieren bzw. deaktivieren. 

Transport-Fenster: Anzeigen der Click- und Tempo-
Bedienelemente

Metronome

Tempo-
Bedienelemente
K
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Timeline und Navigation
In Pro Tools gibt es mehrere 
Navigationsmöglichkeiten, z.B. mit der Maus 
und das Eingeben einer Position in einem der 
Zähler. 

So rufen Sie eine Position im Edit-Fenster auf:

■ Klicken Sie auf die gewünschte Position.

So navigieren Sie mit den Zählern:

■ Klicken Sie in den Hauptzähler und geben Sie 
die gewünschte Position mit der Tastatur ein. 

Navigieren im Edit-Fenster

Navigieren im Zähler

Sie können auch die *-Taste auf dem 
Zahlenblock drücken. 

Klicken Sie in einen Track oder auf eine Time Scale

Klicken Sie in einen Zähler und geben Sie eine Position ein
Erste Schritte mit Mbox
Memory Locations

Mit Hilfe von Memory Locations können Sie 
ebenfalls in einer Session navigieren. 

So definieren Sie eine Memory Location:

■ Drücken Sie bei angehaltener oder laufender 
Wiedergabe die Eingabetaste auf dem 
Zahlenblock. Das New Memory Location-
Dialogfeld wird geöffnet, in dem Sie einen 
Marker definieren, eine Selektion speichern oder 
eine Kombination der anderen verfügbaren 
Einstellungen speichern können. Diese 
Einstellungen sind: Track Height, Group 
Enables, Pre- und Post-roll-Werte und Track 
Show/Hide. Wählen Sie die Einstellungen für 
den Marker und klicken Sie auf OK. 

So rufen Sie eine gespeicherte Memory Location 
auf: 

■ Drücken Sie die Kommataste auf dem 
Zahlenblock, dann die Markernummer und 
erneut die Kommataste. 



Anzeigen und Zoomen

Beim Anzeigen von Tracks im Edit-Fenster 
können Sie die Höhe der Tracks mit dem Track 
Height Selector anpassen und mit die Tracks mit 
den Zoom-Tools vertikal und horizontal 
vergrößern.

So ändern Sie die Darstellungshöhe von Tracks:

■ Klicken Sie auf den Track Height Selector und 
wählen Sie eine Ansichtsgröße aus. 

So vergrößern Sie einen Bereich eines Track im 
Edit-Fenster:

1  Klicken Sie auf den Zoomer.

Zoom- und Track Height-Tools im Edit-Fenster:

Sie können viele Befehle auf mehrere Tracks 
gleichzeitig anwenden, z.B. das Ändern der 
Track-Höhe. Halten Sie die Option-Taste 
(Macintosh) bzw. Alt-Taste (Windows) 
gedrückt während Sie den Vorgang 
ausführen, damit er auf alle Tracks 
angewendet wird. Halten Sie die Shift- und 
Option-Taste (Macintosh) bzw. Shift- und 
Alt-Taste (Windows) gedrückt während Sie 
den Vorgang ausführen, um ihn auf alle 
ausgewählten Tracks anzuwenden.

Zoom-Voreinstellungen

 Zoom-Schaltflächen

Zoomer

Track Height Selector
2  Klicken oder ziehen Sie mit dem Zoomer, um 
die Darstellung eines Tracks oder eines Ruler 
horizontal zu vergrößern. 

So vergrößern bzw. verkleiner Sie in Schritten:

■ Klicken Sie auf die entsprechende Zoom-
Schaltfläche. 

• Pfeil nach links (horizontal verkleinern)

• Pfeil nach rechts (horizontal vergrößern)

• Waveform- und MIDI-Schaltflächen zum 
Erhöhen bzw. Verringern der vertikalen 
Vergrößerung des entsprechenden 
Tracktyps (Audio oder MIDI)

Pro Tools enthält auch fünf Zoom-
Voreinstellungsschaltflächen. Mit diesen 
können Sie festgelegte Zoom-Stufen aufrufen. 
Sie können diese Vergrößerungsfaktoren für 
jede Schaltfläche pro Session definieren.

So rufen Sie eine gespeicherte Zoom-
Voreinstellung auf:

■ Klicken Sie auf die entsprechende Zoom-
Voreinstellungs-Schaltfläche (1-5).

So speichern Sie eine Zoom-Voreinstellung:

■ Klicken Sie bei gedrückter Apfeltaste auf eine 
Zoom-Voreinstellungs-Schaltfläche, um die 
aktuellen horizontalen und vertikalen Zoom-
Werte für diese Schaltfläche zu speichern. 

Verwenden von Memory Locations zum Zoomen 
der Ansicht

Mit Hilfe von Pro Tools-Memory Locations 
können Sie viele Attribute mit jedem Marker 
bzw. Memory Location speichern, z.B. auch 
Track Height- und Zoom-Einstellungen. Wenn 
Sie Memory Locations erstellen, die weder 
Marker noch Selektionen sind, sondern Track 
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Height-, Zoom- und andere Einstellungen 
enthalten, können Sie mit diesen über den 
Zahlenblock die Ansicht vergrößern bzw. 
verkleinern.

Tracks
Mit Pro Tools können Sie Audio- und MIDI-
Spuren zur Audio- und MIDI-Aufnahme, -
Abmischung, -Routing, -Automatisierung und -
Bearbeitung erstellen.

So erstellen Sie einen neuen Track:

■ Wählen Sie File > New Tracks. 

Pro Tools bietet vier Track-Typen: Audio, 
Auxiliary Input, Master Fader und MIDI. Audio, 
Auxiliary-Eingänge und Master Fader können 
Mono oder Stereo sein.

Audio-Tracks Aufnehmen und Wiedergeben von 
Audio auf und von Festplatte, Abhören von 
scharfgeschalteten Audio-Eingängen und 
Bearbeiten von Audio-Regions.

Auxiliary-Eingänge Audio-Mischkanäle für 
Eingabe, Routing und Abmischen.

Master Fader Master-Kanalregler und -optionen 
für beliebige Output- bzw. Bus-Pfade.

MIDI-Tracks Aufnehmen, Wiedergeben und 
Bearbeiten von MIDI-Daten.

New Track-Dialogfeld
Erste Schritte mit Mbox
Audio-, Auxiliary-Eingang-, Master Fader- und 
MIDI-Tracks erscheinen als vertikale Kanalzüge 
im Mix-Fenster. Der Track-Typ wird über Track 
Type-Symbole unter den Fadern angegeben. 

Im Edit-Fenster werden Tracks horizontal 
entlang der Timeline angezeigt. Das 
Audiomaterial für jeden Track erscheint in der 
Playlist. 

Audio-, Auxiliary-Eingangs-, Master Fader- und 
MIDI-Tracks können automatisiert werden 
(siehe “Mischautomation“ auf Seite 34).

Tracks im Mix-Fenster

Timeline Ruler und ein Stereo-Audio-Track im Edit-
Fenster

Audio Aux.- Master- MIDI
FaderEingang

Audio-Track

Timeline- 
Rulers-
Ansicht



Abbildung 4.  Stereo-Audio-Track im Mix-Fenster

Track-Name

Pegelanzeigen (Stereo)

Panoramaregler

Mute-Schaltfläche

Übersteuerungsanzeige

Eingang
Ausgangssignale
Lautstärke
Panorama
Automationsmodus

Aufnahme
Solo

Fader
(rot)

Output-Fenster öffnen

Voice Selector

Inserts

Sends

Aktivierung 
von Groups
Audio-Tracks

Alle Audio-Tracks (Audio- (Festplatten-)Tracks, 
Auxiliary-Eingänge oder Master Fader) nutzen 
die gleichen Bedienelemente. Abbildung 4 zeigt 
die Bedienelemente in einem Audio- oder 
Auxiliary-Eingangs-Track. 

Master Fader-Tracks enthalten dieselben 
Funktionen wie Audio- und Auxiliary-Eingangs-
Tracks mit folgenden Ausnahmen: 

Input Selector Die Ausgangszuweisung eines 
Master Fader bestimmt den Eingang bzw. die 
Quelle.
Sends Master Faders stellen keine Sends zur 
Verfügung. Verwenden Sie stattdessen 
Auxiliary-Eingänge oder weisen Sie den Ausgang 
mehrfach zu.

MIDI-Tracks

MIDI-Tracks enthalten Bedienelemente für 
Track-Pegel, Solo und Mute sowie MIDI-
Eingang, -Ausgang, -Kanal und Programm 
(Patch). MIDI-Lautstärke, Mute und Panorama 
können auch in Pro Tools automatisiert werden 
(siehe “Mischautomation“ auf Seite 34).
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Editieren
Pro Tools enthält viele Tools zum Editieren von 
Audio- und MIDI-Tracks. Das Editieren 
geschieht überwiegend im Edit-Fenster. Die 
Symbolleiste im Edit-Fenster enthält Edit-
Modus und Edit Tool-Selectors. 

Das Editieren von Audio und MIDI wird 
verwendet zum:

• Beheben bzw. Ersetzen von Fehlern

• Erneuten Arrangieren von Songs und 
Projekten

• Bereinigen des Track-Timing und -Rhythmus 
durch Anpassen von Schlägen auf Grid-Werte 
wie Takte und Schläge, Timecode oder andere 
Timebases. 

• Erstellen von endgültigen Tracks mit 
Selektionen aus mehreren Takes (auch comp-
Track oder Compilation genannt)

Playlists und nicht-destruktives 
Editieren

Mit Playlists können Sie mehrfache Versionen 
von Track-Edits erstellen und abrufen. Eine 
Playlist kann einen vollständigen Take, einen 
Overdub oder ein Arrangement von Selektionen 
aus meheren Takes enthalten. Sie können 
Playlists duplizieren, um Edits im aktuellen 
Zustand zu speichern und dann weitere Edits an 
der neuen Playlist vornehmen, mit der 
Sicherheit, dass Sie jederzeit zur ursprünglichen 
Version zurückkehren können. 

Edit-Modi und Tools (Grid-Modus, SmartTool aktiviert)

Edit-Modi Edit Tools
Erste Schritte mit Mbox
Das Mischpult
Die Pro Tools-Mischumgebung mit vielen 
vertrauten Kanalzügen für Track-Pegel, 
Panorama, Solo und Mute. Mischpult- und I/O-
Bedienelemente können sowohl im Mix- als 
auch im Edit-Fenster angezeigt werden.

Grundlagen des Signal-Routing

Signal-Routing wird durch Zuweisen von Track-
Ein- und -Ausgängen erreicht. Audio-Track-
Eingänge können aus einer beliebigen 
Hardware-Quelle kommen. Nach der Aufnahme 
ist die Eingabe eines Audio-Track die 
entsprechende Audio-Datei auf der Festplatte. 
Der Eingang eines Auxiliary-Tracks kann ein 
beliebiger Hardware-Eingang oder ein interner 
Mischbus sein. Für alle Audio-Track-Typen 
können die Ausgänge auf einen beliebigen 
Hardware-Ausgang oder internen Bus-Send 
geroutet werden.

Mit diesen Signal-Routing-Funktionen können 
Sie praktisch jede Mischpultarchitektur 
einrichten, die Sie für Ihre Projekte benötigen, 
auch Sends und Returns für die 
Effektverarbeitung und zum Submixen.

Duplizieren einer Playlist



Beispiel für Send und Return

Auxiliary-Eingangs-Tracks können als Return-
Kanäle für Busse eingerichtet werden sowie für 
Eingänge von Hardware-Quellen. 

Master Fader

Master-Fader werden zur Ausgangs- und Bus-
Master-Pegelsteuerung verwendet. Master Fader 
können für Master-Pegel, Solo, Mute und Insert-
Zuweisungen (Plug-Ins oder Hardware-Inserts) 
eines beliebigen Mono- oder Stereo-Ausgangs- 
oder Buspfads verwendet werden. 

Die für Eingänge, Ausgänge und Busse 
verfügbaren Optionen werden im I/O Setup-
Dialogfeld konfiguriert. Weitere Informationen 
zum I/O Setup-Dialogfeld finden Sie im 
Pro Tools Referenzhandbuch. 

Für Send und Return konfigurierte Audio- und Auxiliary-
Eingangs-Tracks

Send zu Bus 9-10 Aux Input Eingang von Bus 9-10

Send-Fenster
Plug-Ins
Über Plug-Ins werden EQ-, Dynamik-, Delay- 
und viele andere Effekte zur Verfügung gestellt. 

Plug-Ins laufen entweder in Echzeit oder nicht. 
RTAS-Plug-Ins sind nicht-destruktive Effekte, 
die während der Wiedergabe in Echtzeit zum 
Verarbeiten von Audio in Tracks eingefügt 
werden, wie ein externer Hardware-Prozessor. 
AudioSuite-Plug-Ins dagegen sind destruktive 
Effekte, die nicht in Echtzeit Audiodateien auf 
der Festplatte verarbeiten.

Echtzeit-Plug-Ins werden Tracks im Inserts-
Bedienfeld des Mix- oder Edit-Fensters 
zugewiesen. Sind sie einmal zugewiesen, 
erscheinen Plug-Ins im Inserts-Bedienfeld eines 
Tracks und können durch Klicken auf die Insert-
Schaltfläche geöffnet werden.

Kompressor-Plug-In

Plug-InInsert-Schaltfläche
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Im Lieferumfang von Pro Tools ist eine 
vollständige Reihe von DigiRack-Plug-Ins 
enthalten. Viele weitere sind von Digidesign 
und unseren Entwicklungspartnern erhältlich. 

Mischautomation
Bei der Mischautomation können Sie 
Änderungen an Track- und Send-Pegeln, Mute-, 
Pan- und Plug-In-Parametern aufzeichnen oder 
automatisieren. Bei MIDI-Tracks können nur 
Track-Pegel, Panorama und Mute automatisiert 
werden.

Die grundlegenden Schritte zur 
Automationsaufzeichnung sind folgende:

1  Aktivieren Sie im Automation Enable-Fenster 
den gewünschten Automationstyp(Lautstärke, 
Panorama, Send-Pegel, Send-Panorama, Send-
Stummschaltung oder Plug-In-Automation).

2  Wählen Sie einen Automationsmodus für die 
zu automatisierenden Tracks aus (Write, Touch, 
Latch oder Trim). 

Weitere Informationen zu Plug-Ins finden 
Sie im DigiRack Plug-Ins Handbuch, dem 
Digidesign Plug-Ins Handbuch und dem 
Plug-Ins-Kapitel des Pro Tools 
Referenzhandbuchs. 
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3  Starten Sie die Wiedergabe und beginnen Sie 
mit der Automationsaufzeichnung, indem Sie 
die gewünschten Fader und Regler einstellen. 
Pro Tools speichert alle Bewegungen, die auf 
aktivierten Parametern ausgeführt wurden.

Nach der Aufzeichung kann die Automation 
erneut aufgezeichnet oder im Edit-Fenster 
grafisch angezeigt und bearbeitet werden. 

Aktivieren der Automation (links) und Einstellen eines 
Track-Automationsmodus (rechts)

Lautstärkenautomation in einem Track im Edit-Fenster

Pro Tools stellt außerdem einen 
Automation Safe-Modus für den Schutz der 
Plug–In-Automation vor Überschreiben 
sowie viele Automation Preferences zum 
Feinabstimmen der Systemleistung zur 
Verfügung. Weitere Informationen hierzu 
finden Sie im Pro Tools Referenzhandbuch.

Track-Ansicht: Volume

Breakpoint-Lautstärkeautomation



Grundlegendes zum 
Aufnehmen
In diesem Abschnitt wird beschrieben, wie Sie in 
Pro Tools Audio- und MIDI-Tracks aufnehmen. 

Routen von Audiosignalen auf einen 
Track

So routen Sie Audiosignale auf einen Track:

1  Überprüfen Sie die Kabelverbindungen zu den 
Instrumenten. Im Handbuch zum Audio-
Interface finden Sie ausführliche Informationen 
zum Einrichten des Studios.

2  Erstellen Sie einen Track, indem Sie File > New 
Track wählen. Wählen Sie 1 Mono Audio Track 
und klicken Sie auf Create.

3  Suchen Sie im Mix-Fenster die I/O-
Bedienelemente für den Track. Sind diese nicht 
eingeblendet, wählen Sie Display > Mix 
Window Shows > I/O View. Die I/O-Ansicht 
befindet sich unter den Sends und über den 
Solo- und Mute-Schaltflächen.

4  Klicken Sie auf die Input-Schaltfläche des 
neuen Tracks. 

Wählen Sie im Popup-Menü den 
aufzunehmenden Eingang aus. Das Menü 
enthält die Namen der Eingänge, die im im 
Hardware Setup- bzw. I/O Setup-Dialogfeld 
definiert wurden.

Routen eines Eingangssignals auf einen Mono-Track
Einstellen der Pegel

Passen Sie den Eingangspegel an der Quelle 
(Instrument, Mikrofonvorverstärker oder 
Mischpult) an, um die Pro Tools-
Aufnahmepegel festzulegen. Beim Einstellen der 
Eingangspegel ist es wichtig, das Signal so laut 
wie möglich zu empfangen, ohne dabei digitale 
Übersteuerungen zu verursachen. Signale, die 
den oberen Bereich der Pegelanzeige in 
Pro Tools erreichen, nutzen einen größeren 
Anteil des Bitbereichs aus (die 24 Bit, aus denen 
ein Audio-Sample besteht). Je besser Sie diesen 
Bitbereich ausreizen können, desto besser wird 
die Tonqualität sein. Wenn Sie die optimalen 
Pegel einstellen, erhalten Sie die 
geringstmöglichen Rausch- und 
Verzerrungsstörungen.

Achten Sie auf digitale Übersteuerungen. 
Dieser Effekt tritt auf, wenn Sie ein Signal 
an ein Audiogerät senden, das lauter ist, als 
das Gerät akzeptiert, wodurch Verzerrungen 
entstehen. Digitale Übersteuerungen 
klingen sehr hart und sollten normalerweise 
unbedingt vermieden werden. Achten Sie 
daher auf die Pegelanzeigen!

Eine Erhöhung der Verstärkung führt zu 
einem erhöhten Grundrauschen. 
Vergewissern Sie sich, dass das 
angeschlossene Gerät ein möglichst starkes 
Signal ohne Verzerrungen ausgibt.
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Aufnehmen eines Audio-
Tracks

So nehmen Sie einen Audio-Track auf:

1  Schalten Sie den gewünschten Track scharf 
und weisen Sie ihm einen Eingang zu. Stellen Sie 
die Eingangspegel entsprechend ein.

2  Rufen Sie das Transport-Fenster auf (Windows 
> Show Transport) und klicken Sie auf Return to 
Zero, um an den Anfang der Session 
zurückzukehren. Sie können für die Aufnahme 
auch eine Selektion vornehmen oder sie an der 
aktuellen Cursor-Position im Edit-Fenster 
beginnen lassen.
Erste Schritte mit Mbox
3  Klicken Sie im Transport-Fenster auf Record, 
um Tracks für die Aufnahme scharfzuschalten.

4  Klicken Sie auf Play oder drücken Sie die 
Leertaste, um die Aufnahme auf allen 
scharfgeschalteten Tracks zu starten.

5  Beginnen Sie mit dem Spielen des 
Instruments.

6  Klicken Sie im Transport-Fenster auf Stop, 
oder drücken Sie die Leertaste, wenn Sie mit der 
Aufnahme fertig sind.
Aufnehmen vom Beginn einer Session an

Return to Zero Klicken Sie, um die 
Aufnahme vom Beginn einer Session 
zu starten

Klicken Sie hier, um den Track für die Aufnahme
scharfzuschalten (leuchtet nun rot)

Klicken Sie auf Play, um die Aufnahme zu starten



Aufnehmen von der Cursor-Position im Edit-Fenster an

1

23

4

5

Klicken Sie auf das Selector-Tool

Der rote Pfeil zeigt an, dass die 
Aufnahme an der Cursor-Position 
gestartet wird

Schalten Sie den 
Track scharf

Positionieren Sie den 
Cursor an der Stelle, an 
der Sie mit der 
Aufnahme beginnen 
möchten

Klicken Sie hier, um den Track für die Aufnahme scharfzuschalten 
(leuchtet nun rot)

Klicken Sie auf Play, um die Aufnahme zu starten
So spielen Sie einen aufgenommenen Track ab:

1  Heben Sie die Scharfschaltung für den Track 
durch nochmaliges Klicken auf die Record-
Schaltfläche für den Track auf. Die Schaltfläche 
sollte jetzt nicht mehr aktiv sein.

2  Klicken Sie im Transport-Fenster auf Play oder 
drücken Sie die Leertaste, um den Track 
abzuspielen. 

3  Klicken Sie im Transport-Fenster auf Stop, 
oder drücken Sie die Leertaste, wenn Sie mit der 
Aufnahme fertig sind.
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 Erste Schritte mit Mbox
Aufnahme über die Länge einer Selektion im Edit-Fenster

1

23

4

5

Klicken Sie auf das Selector-Tool

Diese Pfeile, die die Selektion markieren,
leuchten rot und zeigen damit an, dass die
Aufnahme über die Länge der Selektion
erfolgt

Selektieren Sie den 
Bereich, in dem Sie 
aufnehmen möchten

Klicken Sie hier, um den Track für die Aufnahme scharfzuschalten 
(leuchtet nun rot)

Klicken Sie auf Play, um die Aufnahme zu starten

Schalten Sie den 
Track scharf
Aufnehmen von MIDI

So konfigurieren Sie einen neuen MIDI-Track für 
die Aufnahme:

1  Wählen Sie File > New Track, geben Sie unter 
MIDI Track die Zahl 1 an, und klicken Sie auf 
Create.

2  Klicken Sie im Mix-Fenster auf den MIDI 
Device/Channel Selector des Tracks, und 
wählen Sie ein Gerät und einen Kanal aus dem 
Popup-Menü.
3  Sie können dem Track eine Standard-
Programmwechselbefehle zuweisen, indem Sie 
im Mix-Fenster auf die Program-Schaltfläche 
klicken und die erforderlichen Optionen für 
Programm- und Bank-Auswahl ändern. Klicken 
Sie anschließend auf Done. Standard-
Programmwechselbefehle werden beim 
Abspielen eines Tracks gesendet.

MIDI Device/Channel Selector



4  Schalten Sie den MIDI-Track im Mix-Fenster 
scharf.

5  Vergewissern Sie sich, dass MIDI > MIDI Thru 
ausgewählt ist, und spielen Sie dann einige 
Noten auf dem MIDI-Controller. Das dem Track 
zugewiesene MIDI-Instrument sollte erklingen, 
und die Pegelanzeigen des Tracks sollten MIDI-
Aktivität aufzeichnen.

So nehmen Sie den neuen MIDI-Track auf:

1  Vergewissern Sie sich, dass der 
aufzunehmende MIDI-Track scharfgeschaltet ist 
und MIDI-Signale empfängt.

2  Klicken Sie im Transport-Fenster auf Return to 
Zero, um sicherzustellen, dass die Aufnahme am 
Anfang des Track beginnt. Sie können für die 
Aufnahme auch eine Selektion vornehmen oder 
sie an der aktuellen Cursor-Position im Edit-
Fenster beginnen lassen. 

3  Klicken Sie im Transport-Fenster auf Record.

4  Klicken Sie im Transport-Fenster auf Play oder 
drücken Sie die Leertaste, um die Aufnahme zu 
starten.

- oder -

Wenn Sie die Wait for Note-Option verwenden, 
blinken die Play-, Record- und Wait for Note-
Schaltflächen. Die Aufnahme wird gestartet, 
wenn das erste MIDI-Event empfangen wird.

- oder -

Wenn Sie die Countoff-Option verwenden, 
klicken Sie auf Play. Die Record- und Play-
Schaltflächen blinken und die Aufnahme wird 
gestartet.

5  Spielen Sie auf Ihrem MIDI-Instrument.
6  Klicken Sie im Transport-Fenster auf Stop bzw. 
drücken Sie die Leertaste, wenn Sie mit der 
Aufnahme fertig sind. Die neu aufgenommenen 
MIDI-Daten werden im Track im Edit-Fenster als 
MIDI-Region und in der MIDI-Regions-Liste 
angezeigt.

So geben Sie den aufgenommenen MIDI-Track 
wieder:

1  Deaktivieren Sie die Scharfschaltung für den 
MIDI-Track, um den Record-Ready-Modus zu 
deaktivieren.

2  Klicken Sie im Transport-Fenster auf Return to 
Zero.

3  Klicken Sie im Transport-Fenster auf Play, um 
die Wiedergabe zu starten. Die aufgenommenen 
MIDI-Daten werden über das dem Track 
zugewiesene Instrument und den zugewiesenen 
Kanal abgespielt.

Abhören von MIDI-Instrumenten ohne 
Mischpult

Erstellen Sie zum Abhören des MIDI-
Instruments einen Auxiliary-Eingang. Auxiliary-
Eingänge fungieren als Eingänge für über 
interne Busse geroutete Signale als auch für 
externe Audioquellen.

So konfigurieren Sie einen Auxiliary-Eingang für 
das Abhören von MIDI:

1  Verbinden Sie den Audio-Ausgang des MIDI-
Instruments mit dem entsprechenden Eingang 
des Audio-Interface.

2  Wählen Sie File > New Track, geben Sie einen 
Mono bzw. Stereo-Auxiliary-Eingangs-Track an 
und klicken Sie auf Create.

3  Klicken Sie auf den Input Selector des 
Auxiliary-Eingangskanals und wählen Sie den 
Eingang, an den Ihr MIDI-Instrument 
angeschlossen ist. 
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4  Klicken Sie auf den Output Selector des 
Auxiliary-Eingangskanals und wählen Sie einen 
Ausgang aus.

5  Stellen Sie mit Hilfe des Faders auf dem 
Auxiliary-Eingangskanal den gewünschten 
Pegel für den Eingang ein.
Erste Schritte mit Mbox
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